




Beta Draft: 2011-03-02

4 Retrieving and Updating with Oracle Data Provider for .NET
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Using the Command Object

To view, edit, insert or delete data in a database, you must encapsulate a request in an OracleCommand object specifying a SQL command, stored procedure, or table name. The OracleCommand object creates the request, sends it to the database, and returns the result.


To use the command object:

	
Make two copies of Form1.xx, from application HR_Connect_xx in Chapter 3, "Building a Simple .NET Application Using ODP.NET". To make copies, see the instructions in Appendix B, "Copying a Form".

Name the copies Form2.cs or Form2.vb and Form3.cs or Form3.vb. The first copy is for the first part of the chapter, and the second copy for the second part of the chapter


	
Open Form2.cs or Form2.vb.

Note that the actual form in the designer still says Form1, as you renamed code files but not the actual form controls within the project.


	
Create a string that represents the SQL query and add to the body of the try statement.

The new code is in bold typeface.

Visual C#:



try
{
    conn.Open();
    connect.Enabled = false;
 
    // SQL Statement
    string sql = "select department_name from departments"
       + " where department_id = 10";
}


Visual Basic:



Try
      conn.Open()
      connect.Enabled = False
 
     Dim sql As String = "select department_name from departments" & _
       "where department_id = 10"
 


	
Use the new sql variable to create the OracleCommand object, and set the CommandType property to run a text command.

Visual C#:


try
{
    conn.Open();
    connect.Enabled = false;
 
    // SQL Statement
    string sql = "select department_name from departments"
       + " where department_id = 10";

OracleCommand cmd = new OracleCommand(sql, conn);
cmd.CommandType = CommandType.Text;
}


Visual Basic:


Try
      conn.Open()
      connect.Enabled = False
 
      Dim sql As String = "select department_name from departments" & _
         "where department_id = 10"
 
Dim cmd As New OracleCommand(sql, conn)
cmd.CommandType = CommandType.Text


	
Save your work.









Retrieving Data: a Simple Query

This section demonstrates retrieving data from the database.

The ExecuteReader() method of an OracleCommand object returns an OracleDataReader object, which can be accessed to display the result on the form. The application uses a ListBox to display the results.


To retrieve data:

	
Create an OracleDataReader object, by adding the code indicated to the bottom of the Try block of the connect_Click() method.

This enables you to read the result of the query.

Visual C#:



OracleDataReader dr = cmd.ExecuteReader();
dr.Read();


Visual Basic:



Dim dr As OracleDataReader = cmd.ExecuteReader()
dr.Read()


	
Open Form1 in Design view. From the View menu, select Designer.


	
From the View menu, select Toolbox.


	
From the Toolbox, select a Label and drag it onto Form1.


	
From the View menu, select Properties Window.


	
In the Properties window, change the Text of the label to Department.


	
From the Toolbox, under Window forms, select a ListBox and drag it onto Form1.


	
In the Properties window, under Design, change the Name to departments.

[image: Description of simple1.gif follows]




	
Add accessor type methods for retrieving data from the query result.

Double-click the connect button to edit the connect_click() method, and add the code indicated to the bottom of the try block.

Visual C#:



departments.Items.Add(dr.GetString(0)); 


Visual Basic:



departments.Items.Add(dr.GetString(0))


Typed accessors, such as GetString, return native .NET data types and native Oracle data types. Zero-based ordinals passed to the accessors specify which column in the result set to return.


	
Build and save the application.


	
Run the application. Enter the login and data source.

After you connect, the departments list box shows Administration, the correct name for department number 10 in the HR schema, as requested by the SELECT statement.

[image: Description of simple2.gif follows]











Retrieving Data: Bind Variables

Bind variables are placeholders inside a SQL statement. When a database receives a SQL statement, it determines if the statement has already been executed and stored in memory. If the statement does exist in memory, Oracle Database can reuse it and skip the task of parsing and optimizing the statement. Using bind variables makes the statement reusable with different input values. Using bind variables also improves query performance in the database, eliminates the need for special handling of literal quotation marks in the input, and protects against SQL injection attacks.

The following code shows a typical SELECT statement that does not use bind variables, with the value 10 specified in the WHERE clause of the statement.



SELECT department_name FROM departments WHERE department_id = 10


The following code replaces the numerical value with a bind variable :department_id. A bind variable identifier always begins with a single colon ( :).


SELECT department_name FROM departments WHERE department_id = :department_id


Note that bind variables can also be used with UPDATE, INSERT, and DELETE statements, and also with stored procedures. The following code illustrates how to use bind variables in an UPDATE statement:


UPDATE departments SET department_name = :department_name
  WHERE departname_id = : department_id


See "Inserting, Deleting, and Updating Data" for more details.

You can use the OracleParameter class to represent each bind variable in your .NET code. The OracleParameterCollection class contains the OracleParameter objects associated with the OracleCommand object for each statement. The OracleCommand class passes your SQL statement to the database and returns the results to your application.

You can bind variables by position or by name by setting the OracleCommand property BindByName (which defaults to false).

	
Binding by position

You must use the Add() method to add the parameters to the OracleParameterCollection in the same order as they appear in the SQL statement or stored procedure.


	
Bind by name

You may add the parameters to the collection in any order; however, you must set the ParameterName property for the parameter object to the same name as the bind variable identifier in the stored procedure declaration.




In addition to the binding mode (by position or by name), the .NET developer sets the following properties for each parameter object: Direction, OracleDbType, Size, and Value.

	
Direction Bind variables may be used as output, input, or input/output parameters. The Direction property indicates the direction of each parameter. The default value of the Direction property is Input.


	
OracleDbType property indicates whether or not the parameter is a number, a date, a VARCHAR2, and so on.


	
Size indicates the maximum data size that parameters with a variable length data type, such as VARCHAR2, can hold.


	
Value contains the parameter value, either before statement execution (for input parameters), after execution (for output parameters), or both before and after (for input/output parameters).





To retrieve data using bind variables:

	
Move the ListBox named Departments to the right.


	
From the View menu, select Toolbox.


	
From the Toolbox, select a TextBox and drag it onto Form1, under the label that says Department.


	
From the View menu, select Properties Window.


	
In the Properties window, change Name to departmentID.

[image: Description of bind0.gif follows]




	
Change the SELECT statement to use the bind variable by adding the code indicated to the Try block of the connect_Click() method.

Changed or new code is in bold typeface.

Visual C#:



string sql = "select department_name from departments where department_id = " +
  ":department_id";
OracleCommand cmd = new OracleCommand(sql, conn);
cmd.CommandType = CommandType.Text;
OracleParameter p_department_id = new OracleParameter(); 
p_department_id.OracleDbType = OracleDbType.Decimal;     
p_department_id.Value = departmentID.Text;                              
cmd.Parameters.Add(p_department_id);                     

OracleDataReader dr = cmd.ExecuteReader();
dr.Read();

departments.Items.Add(dr.GetString(0));


Visual Basic:



Dim sql As String = "select department_name from departments where" & _
  "department_id= ":department_id"
Dim cmd As OracleCommand = New OracleCommand(sql, conn)
cmd.CommandType = CommandType.Text
Dim p_department_id as OracleParameter = new OracleParameter() 
p_department_id.OracleDbType = OracleDbType.Decimal     
p_department_id.Value = departmentID.Text
cmd.Parameters.Add(p_department_id) 

Dim dr As OracleDataReader = cmd.ExecuteReader()
dr.Read()

departments.Items.Add(dr.GetString(0))


For this code, the parameter object sets the OracleDbType property, but there is no need to set the Direction property because it uses the default value, Input. There is no need to set the Size property because the object is an input parameter, and the data provider can determine the size from the value.


	
Save and run the application.


	
Enter the login information, and a typical department number, such as 50, from the HR schema.


	
Click Connect.

The application returns the name of the department that corresponds to the department ID.

[image: Description of bind1.gif follows]











Retrieving Data: Multiple Values

You frequently need to retrieve more than just one value from the database. A DataReader object can retrieve values for multiple columns and multiple rows. Consider the multiple column, multiple row query in the following example:



SELECT department_id, department_name, manager_id, location_id
  FROM departments
  WHERE department_id < 100


Processing multiple rows from the DataReader object requires a looping construct. Also, a control that can display multiple rows is useful. Because the OracleDataReader object is a forward-only, read-only cursor, it cannot be bound to an updatable or backward scrollable control such as Windows Forms DataGrid control. An OracleDataReader object is, however, compatible with a ListBox control.


To retrieve multiple values:

	
In the try block of the connect_Click() method, change the SQL query to return a multiple row result set and add a while loop to enclose the read method that displays the department names.

Visual C#:



try
{
  ...
string sql = "select department_name from departments where department_id" +
  "< :department_id";
...
  while (dr.Read())
  { 
    departments.Items.Add(dr.GetString(0));
  }
}


Visual Basic:



Try
  ...
  Dim sql As String = "select department_name from departments " & _
        "where department_id < :department_id"
...
  While (dr.Read())
    departments.Items.Add(dr.GetString(0))
  End While


	
Save and run the application.


	
Enter the login information and enter 50 for the department.


	
Click Connect.

The application returns the name of the departments that correspond to the query.

[image: Description of bind2.gif follows]











Using the DataSet Class with Oracle Data Provider for .NET

The DataSet class provides a memory-resident copy of database data. It consists of one or more tables that store relational or XML data. Unlike an OracleDataReader object, a DataSet is updatable and backward scrollable.


To use the DataSet class:

	
If you have not done so before, make another copy of the Form1 that you completed in Chapter 3, and name it Form3.vb or .cs, as described in Appendix B, "Copying a Form". If Form1.xx does not appear in the Solution Explorer, from the Project menu, select Show All Files.


	
From the View menu, select Designer view.


	
From the View menu, select Toolbox.


	
From the Toolbox, select a DataGridView and drag it onto Form1.


	
From the View menu, select Properties Window.


	
In the Properties window, change the Name of the data grid view to departments.

[image: Description of dataset1.gif follows]




	
From the View menu, select Code.


	
Immediately after the conn declaration in the code, add variable declarations to the class variables, as indicated.

Visual C#:



public partial class Form1 : Form
{
  public Form1()
  {
      InitializeComponent();
  }
  private OracleConnection conn = new OracleConnection();
  private OracleCommand cmd;
  private OracleDataAdapter da;
  private OracleCommandBuilder cb;
  private DataSet ds;
...


Visual Basic:



Public Class Form1    Dim conn As New OracleConnection     Private cmd As OracleCommand
    Private da As OracleDataAdapter
    Private cb As OracleCommandBuilder
    Private ds As DataSet


	
Within the connect_Click() method try block, add code to:

	
Query the database


	
Fill the DataSet with the result of the command query


	
Bind the DataSet to the data grid (departments)




Visual C#:



conn.Open();
connect.Enabled = false;
 
string sql = "select * from departments where department_id < 60";
cmd = new OracleCommand(sql, conn);
cmd.CommandType = CommandType.Text;

da = new OracleDataAdapter(cmd);
cb = new OracleCommandBuilder(da);
ds = new DataSet();
 
da.Fill(ds);
 
departments.DataSource = ds.Tables[0];


Visual Basic:


conn.Open()
connect.Enabled = False
 
Dim sql As String = "select * from departments where department_id < 60"
cmd = New OracleCommand(sql, conn)
cmd.CommandType = CommandType.Text
 
da = New OracleDataAdapter(cmd)
cb = New OracleCommandBuilder(da)
ds = New DataSet()
 
da.Fill(ds)
 
departments.DataSource = ds.Tables(0)


	
Build and save the application.


	
Run the application, entering the login and data source.

After you successfully connect to the database, the data grid is populated with the results of the query.

[image: Description of dataset3.gif follows]











Enabling Updates to the Database

At this point, the DataSet contains a client copy of the database data. In this section, you will add a button that enables client data changes to be saved back to the database. The following section will show you how to test updating, inserting, and deleting the data.

To enable saving data from the DataSet to the database:

	
From the Toolbox, drag and drop a Button onto Form1.


	
In the Properties window, change the Name of the button to save.

Change the Text property to Save.


	
At the top of the Properties Window, click Events (the lightning bolt). In the list of events, select the click event. In the second column, enter the event name, save_Click.

[image: Description of dataset2.gif follows]




	
From the View menu, select Code.


	
Add code that updates the data, to the body of the save_Click() method, as indicated.

Visual C#:


da.Update(ds.Tables[0]);


Visual Basic:


da.Update(ds.Tables(0))


You may see some errors show up in the Error List. These will disappear after you add the code in the next step.


	
Within the Form() method or Form1_Load method, add the code indicated.

Visual C#:



public Form1()
{
    InitializeComponent();
    save.Enabled = false;
}


Visual Basic:



Private Sub Form1_Load(ByVal sender As System.Object, & _
    ByVal e As System.EventArgs) Handles MyBase.Load
    save.Enabled = false



	
Within the connect_Click() method try block, add code to enable the Save button as indicated:

Visual C#:


conn.Open();
 ...
departments.DataSource = ds.Tables[0];
 
save.Enabled = true;


Visual Basic:


conn.Open()
...
departments.DataSource = ds.Tables(0)
 
save.Enabled = True


	
Remove the conn.Dispose() call from the finally block in the connect_Click() method.

Note: In the previous code used in this example, this method was necessary to dispose or close the connection. However, with these changes to the code, it is necessary to keep the connection open after the query result returns, so that data changes made by the end user are propagated to the database. A general override call, components.Dispose(), is already part of the definition of Form1.


	
Build and save the application.


	
Run the application, entering the login and data source.

After you successfully connect to the database, the data grid is populated with the results of the query.

[image: Description of dataset3a.gif follows]











Inserting, Deleting, and Updating Data

This section demonstrates how to use your new application to directly manipulate data in the database.


To insert, delete and update data:

	
Run the application you created in the last section, entering the login and data source, and connecting to the database.


	
At the bottom of the data grid, enter a new record at the * prompt:

	
For DEPARTMENT_ID, enter 5.


	
For DEPARTMENT_NAME, enter Community Outreach.


	
Leave MANAGER_ID without a value.


	
For LOCATION_ID, enter 1700.




[image: Description of dataset4.gif follows]




	
Click Save.


	
Close the application to check if the new record is saved.


	
Run the application again, and connect to the database.

Note that the new department is at the top of the DEPARTMENTS table, in numerical order by DEPARTMENT_ID.


	
Change the name of the department to Community Volunteers, and click the Save button.

[image: Description of dataset10.gif follows]




	
Repeat Step 4, run the application again, and connect to the database, and note that the name of the department is changed.


	
Select the entire record you just changed (click the cursor icon in the far left column), and delete it using the Delete key. Click the Save button. [image: Description of dataset11.gif follows]






	
Repeat Step 4, run the application again, and connect to the database, and note that the new record is no longer part of the DEPARTMENTS table.


	
Close the application.
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The graphic is described in the preceding text.


This screenshot shows the Add Connection Dialog. The first field is for Data source and Oracle Database (Oracle ODP.NET) is entered. There is a button to change this.

Then there is the connection details tab with the selected Data source name: orcl

There is the unselected option to use Windows integrated authentication or the selected option to use a specific user name and password, with the entries: User name: HR and Password *******.

There is a check box to Save Password (checked), followed by Role: with Default selected from list. Then a Connection name with HR.orcl.

Last, there are button labeled Advanced, Test Connection, OK, and Cancel.


This screen shot shows the Address, which ends in Default.aspx (http://localhost:1451/WebSite1/Default.aspx). The actual page shows the login, with entry fields for User Name and Password, a check box to Remember me next time (unchecked) and the Log In button.


This window requests that you specify an assembly and a library name.

First, it requests the location of the source assembly. An option for Project is selected.

Second, it requests the name of the library database object to be used for the selected assembly. The drop-down lists shows HR_DEPLOYSTORED_CS_DLL.

There are buttons to go Back, Next, Finish, and Cancel.


The graphic is described in the preceding text, a Form with fields to enter the requested items and a button labeled Connect.


This screen shot shows the Default.aspx source code in the Visual Studio IDE.

There is a heading Client Objects and Events from the list. Below that is the code including an html section that has a title "Untitled Page". At the bottom, are tabs to switch to the Design or Spilt views instead of Source.


The graphic is described in the preceding text.


The graphic shows the Debug Menu, with commands such as Windows, Start Debugging, Start Without Debugging, Attach to Process., Exceptions..., Step Into and others.


The graphic shows salaries for employees with ID below 105. The columns and first line of data are: ID:100, Name, S. King, Salary: 24,005.00.


This screen shot is like the previous one, except there is a right arrow, and the GridView Tasks list is visible. There is a field to Choose Data Source: It shows (None) and underneath that, <New data source...>.


The graphic is described in the preceding text. At the bottom there are Advanced..., Test Connection, Ok, and Cancel buttons.


This graphic shows the Data source: field which is blank, and the Change button.


This graphic illustrates the initial form of the new project C# project, as described in the preceding text.


The graphic shows the New Package window, with these fields and data: Schema name: HR, Package name: HR_DATA, Authentication identifier: DEFINER. There is a checked box for Generate empty package body. Then there is a field for adding methods to the packages. Fields are added by clicking Add button below the field. There are also Edit and Remove section for the methods. Last, there are these buttons: Preview SQL, OK, Cancel, and Help.


The graphic contains the exception error text described in the text, a large X, and buttons for Details, Continue, and Quit.


This shot is described in text.


Figure shows the Server Explorer tree, with SYS.ORCL, and the menu open to highlight the Query Window.



The graphic contains the following code.
CREATE TABLE "DEPENDENTS" (
 "LAST_NAME" VARCHAR2(30) NULL,
 "FIRST_NAME" VARCHAR2(20) NULL,
 "BIRTH_DATE" DATE NULL,
 "RELATIONSHIP" VARCHAR2(20) NULL,
 "EMPLOYEE_ID" NUMBER(6,0) NOT NULL,
 "DEPENDENT_ID" NUMBER(6,0) NOT NULL);



The graphic shows a form with a Connect button and the following fields, User ID, Password, Data Source. There is one large unlabeled field.


The graphic shows the Server Explorer tree with HR.ORCL schema expanded and the Packages node context menu open. It shows commands to New Package..., Privileges..., Refresh, and Properties.


Screen shot shows a grid with dummy titles such as Column0, Column1, etc and dummy contents abc. A right arrow appears in line with the Column titles, which leads to the GridView Tasks list


The graphic is described in the preceding text.


The graphic shows a grid with the same data as the New Data for the DEPENDENTS Table.


This screen shot contains two headings: The first is Membership provider with two choices, OracleMembershipProvider and AspNetSqlMembershipProvider. the second heading is Role Provider with three choices, OracleRoleProvider, AspNetSqlRoleProvider and AspNetWindowsTokenRoleProvider


The graphic shows the Output Window from the build with this text:

Compile complete -- 0 errors, 0 warnings

HR_Connect_CS -> C:\HR_Projects\HR_Connect_CS\HR_Connect_CS\bin\Debug\

HR_Connect_CS.exe

===========Build: 1 succeeded or up-to-date, 0 failed, 0 skipped ======


The graphic is described in the preceding text.


The graphic shows employees with ID below 105. The columns and first line of data are: ID:100, Name, S. King, Short Hire: 17.06.1987, Long Hire Date, Mittwoch, 17 Juni, 1987.


The graphic now shows the Table Designer with the Indexes tab selected. There is one index, Name: Dependents_Index and Type: B-tree. On the right are Index Properties, with Name: Dependents_Index and Type: B-tree, there are check boxes for Unique and Reverse. There is a section on Index Keys: with Key Dependent_ID showing and the Order: Ascending. There are Add and Remove buttons under the Index properties, enabling you to add more properties.


The summary window states that the information needed for the wizard has been specified.

There is a summary that includes the entire assembly path to HR_DeployedStored_CS.dll and the Project Name: HR_DeployedStored_CS.

The screen shot states that the HR_DeployedStored_CS.dll will be copied to the $Oracle_ HOME\bin\clr directory of local database and 1 stored procedure will be deployed to local database.

There is a Show Script button, as well as Back, Next, Finish, and Cancel buttons.


The graphic shows the Add Connection screen with the Apply Filters tab selected. On the left are the Available Schema such as Anonymous, and others. On the right are the Displayed Schemas. This contains the HR schema. There are arrows between the two lists of schema for moving a schema from one side to another. There is a display public synonyms check box. There are Advanced..., Test Connection, OK, and Cancel Buttons.


The graphic shows a list of names that begin with C and their ID. The name order is Cabrio, Cambrault, Cambrault, Colmenares, Chen, and Chung.


The graphic shows Form1 with labels and fields for UserId, Password, and Data Source. There are buttons for Connect, Save and Change Date Format. There is a large empty field that will contain results when the form is run.


The graphic shows the Solution Explorer for the HR_CONNECT_CS project with Copy of Form1.cs selected and expanded. The context menu is open showing commands such as Open, Open With..., View Class Diagram, Include in Project, and so on.


The graphic is described in the preceding text.


This screen shot shows the Run SQL*Plus Script feature. It has groups for File Information, with a field for specifying the full path of the SQL*Plus script with a browse button, Connection Information where the database connection information is specified as SYS.ORCL, with a New Connection button provided for browsing, and finally the Connection String section currently showing DATA SOURCE=ORCL;DBAPRIVILEGE=SYSDBA;PERSIS SECURITY. This is followed by a read-only user input area.There is an executing script bar and Run and Cancel buttons.


The graphic shows the Server Explorer tree with the HR.ORCL expanded, then Tables, then DEPENDENTS. The table menu show is open to show Design..., Retrieve Data..., Add Trigger..., Query Window, Generate Script..., Generate Create Script to Project..., Privileges..., Copy, Delete, Refresh, and Properties.


This screen shot shows the Create User section of the Security page. It has fields for User Name, Password, Confirm Password, E-mail, Security Question, and Security Answer. There is a check box for Active user, and a button to Create User. The shot also contains a second section besides the Create User section. This section is Roles. All it contains is the text "Roles are not enabled".


The graphic displays the declarations section for a Visual Basic application, with the two Imports statements described in the text, plus many others.


The graphic shows a form with a Connect button and the following fields, User ID, Password, Data Source and Departments. There is one large unlabeled field and a Save button.


The graphic shows the Solution Explorer with the HR_CONNECT_CS project selected. The context menu is open showing commands such as Build, Rebuild, Clean, Publish, Add, and so on.


This screenshot shows the Connection Properties Dialog. The first field is for Data source and Oracle Database (Oracle ODP.NET) is entered. There is a button to change this.

Then there is the connection details tab with the selected Data source name: ORCL

There is the unselected option to use Windows integrated authentication or the selected option to use a specific user name and password, with the entries: User name: ASPNET_DB_USER and Password *******.

There is a check box to Save Password (unchecked), followed by Role: with Default selected from list. Then a Connection name with ASPNET_DB_USER.ORCL.

Last, there are button labeled Advanced, Test Connection, OK, and Cancel.


The graphic is described in the preceding text.


The graphic now shows the Table Designer with the Constraints tab selected. There are two unrelated system indexes, and one index for the example, Name: EMPLOYEES_FK and Type: Foreign Key. On the right are Constraints Properties, with EMPLOYEES_FK and Type: Foreign Key, there are check boxes for Deferrable, Enabled (checked), and Validate (checked). There is a disabled field for Execution. There is a section on called Select the foreign key constraint, with Table: EMPLOYEES, and Constraint: EMP_EMP_ID_PK. There is grid called Association: with Referenced Column: EMPLOYEE_ID and Local Column: EMPLOYEE_ID. There is a list called On delete with Cascade selected.


The graphic shows the Run Procedure window. It has a grid titled Parameters. Under this are fields and Data as follows: Name:DEP_ID, Direction: IN, DATA TYP: NUMBER, and Value 60 from a list. There are buttons for OK, Cancel, and Help.


The graphic shows the OUI Welcome screen. It has the following buttons: Deinstall Products, About Oracle Universal Installer..., Help, Installed Products..., Back, Next, Install, and Cancel.


The graphic shows the Server Explorer tree with HR.ORCL expanded. Under Packages HR.DATA is expanded and GETCURSORS is selected and the context menu displayed. It shows commands to Run, Run Debug, Step Into, and so on.


The graphic is described in the preceding text.


The graphic is described in the preceding text.


This screen shot shows the Security page which was previously shown., however, now the Users heading has the following under it: Existing Users: 0, and two links, Create user and Manage users.


The graphic is described in the preceding text.


The graphic displays the View menu, with these available commands, Code, Designer, Server Explorer, Solution Explorer, and Class View.


The graphic is described in the preceding text.


This graphic shows the same view as the previous shot, except that the mouse is poised over the far left column, highlighting the whole row for deletion.


The graphic is described in the text. After the Data connection list, there is a browse button to find other possible connections. Below that is a paragraph asking if you want to permit sensitive data to appear in the connection string. There are No and Yes options to check. Below that is a plus sign (+) labeled Connection string, which expands to display the connection string.


The graphic shows the Add Method window. It has these fields and data: Method name:GETCURSORS, Method type: Procedure, Return type: a disabled field that says NUMBER. The text describes the Parameters: area where you add and remove parameters, and the Parameter Details field where you add details about the parameters.


This screen shot shows the Security page, which has the headings Users with one link, Select authentication type, Roles with one link, Enable roles, and Access Roles with two links, Create access rules and Manage access rules.


The graphic illustrates this step of the procedure. It is described in the preceding text.


The security page now shows the heading Create User with the text Complete. Your account has been successfully completed. There is a Continue button. There is also a Roles section which still indicates that Roles are not enabled.


This screen shot asks: "How will users access your site?" and there are two options: From the internet and From a local network. At the end, is the Done button.


The graphic shows the Server Explorer, with Data Connections highlighted and the HR.ORCL connection expanded.


The graphic shows a grid labeled Parameters: The columns and data are: Name:EMPLOYEE_ID, Direction: IN, Data Type: BINARY_INTEGER, and Value:100. There are OK, Cancel and Help buttons.


The graphic is described in the preceding text. It shows a tree of Tables, with DEPENDENTS(HR) checked. Below that there is a field named DataSet name: with the entry tableDependents. Below that are Previous, Next, Finish, and Cancel buttons.


The graphic now shows the grid with the additional information described in the text.


This shot shows the Solution Explorer, with Solution WebSite1 expanded to show C:\HR_Projects\WebSite1, expanded to show App_Data, Default.aspx, and web.config.


The graphic shows a list of names that begin with C and their ID. The name order is Cabrio, Cambrault, Cambrault, Chen, Chung, and Colmenares.


The graphic shows the following: ERROR at line 1: ORA-00946: Table ou vue inexistante.


The graphic illustrates this step of the procedure. It is described in the preceding text.


The graphic shows a form with a Connect button and the following fields and entries, User ID:hr, Password:*********, Data Source orcl and Departments: Administration.


This screen shot shows the Run SQL*Plus Script feature. It has groups for File Information, with a field for specifying the full path of the SQL*Plus script with a browse button, Connection Information where the database connection information is specified as ASPNET_DB_USER.ORCL, with a New Connection button provided for browsing, and finally the Connection String section currently showing DATA SOURCE=ORCL;PERSIS SECURITY INFO=False;USER. This is followed by a read-only user input area.There is an executing script bar and Run and Cancel buttons.


The graphic shows a form with a Connect button and the following fields and entries, User ID:hr, Password:*********, Data Source orcl and a grid showing DEPARTMENT_ID, DEPARTMENT_NAME, MANAGER_ID, AND LOCATION_ID. The first line is 5, Community Outreach, blank and 1700. the second line is 10, Administration, 200, and 1700. The third line is 20, Marketing, and so on.


The graphic shows the Build menu, with the Build Solution command highlighted.


The graphic shows the Build menu, with the Deploy Solution command highlighted.


The graphic is described in the preceding text.


The graphic contains the following code.


CREATE  INDEX "DEPENDENTS_INDEX" 
 ON "DEPENDENTS" (
  "DEPENDENT_ID");



This shot shows the browser window described in the text. The first line of the page is Employees List. At the bottom, are numbers, 23456 etc for paging through the data.


The graphic shows employees with ID below 105. The column labels and first data line are: EMPLOYEE_ID, FIRST_NAME: Steven, LAST_NAME: KING, and Hire Date: 17-Jun-87.


The graphic shows the installer verifying that the environment meets the minimum requirements for the products you have chosen to install. It shows a grid with titles Check, Type and Status. The highlighted item is "Checking Oracle Home path for spaces...", with Type: Automatic and Status: Succeeded.


The graphic shows a form with a Connect button and the following fields, User ID, Password, Data Source and Departments. The Departments field contains departments.


The graphic is the same as at the end of the previous section, except that now it has a Save button.


The graphic shows a Data Sources window, with a tree expanded from tableDependents, with the DEPENDENTS table under it.


This graphic shows the Query Window with the select statement described in the text in the input section and the result 90 in the Query Result section.


The graphic says that the Test connection succeeded. There is an OK button.


The graphic shows the Server Explorer tree, with the following expanded, HR.ORCL schema, then tables, then Indexes, then the DEPENDENTS_INDEX.


The graphic shows a form with a Connect button and the following fields and entries, User ID:hr, Password:*********, Data Source orcl and a Department a list field showing Administration, Marketing, Purchasing, and Human Resources.


This graphic shows Form1 with fields and data: UserID HR, Password: XXXXX, Data Source ORCL and a Connect button that is disabled. Then there is a grid showing Salary, Commision_PC, Manager_ID, Department_ID and so on. Then there is a Save button.


The graphic shows a form with a Connect button and the following fields and entries, User ID:hr, Password:*********, Data Source orcl and Department: 50, and a list field showing Shipping.


This screen shot shows the above with C:\HR_Projects\WebSite1 highlighted and its menu showing, with Add New Item... highlighted.


This shows the Test Query screen again, this time the blank space is filled with EMPLOYEE_ID, FIRST_NAME, LAST_NAME, and other employee related columns and the first five employees show up.


The graphic shows the previous constraint, plus a new one, Name: DEPENDENTS_PK and Type: Primary Key. The constraint properties are Enabled: checked, Validate: checked, Primary key columns: DEPENDENT_ID, and Using index: DEPENDENTS_INDEX.


The graphic indicates that Oracle Data Access Components for Oracle Client are being installed. The required components are listed in the text. There is a Components column with check boxes and an Install Status column. There are buttons to Expand All, Collapse All, Select All, Deselect all, Help, Installed Products, Back, Next, Install, and Cancel. There is a check box to Show all components, including required dependencies.


The graphic shows the Class1.cs code. It shows the beginning of public class Class1 and under that the first six line of the code listed above for the getDepartmentno function.


The graphic shows the Oracle Server Login, with connection name HR.ORCL and a masked password. There is a check box to Save password and OK, Cancel and Help buttons.


The User Name is Anne, with a password. The login screen says "Your login attempt was not succesful. Please try again."


This screen shot is described in the text. The login control contains the heading Login In and a field to enter the User Name and Password. There is a check box to Remember me next time, and then a Login In button.

Also, on the right side is an arrow which when clicked shows the Login Tasks: Auto Format... , Convert to Template, and Administer Website.


The window shows the Schema: SYS from a list, Object type: USER from a list, and ObjectName: ANONYMOUS, which is indicated to be disabled, also from a list.

There is a User/Role section. User is selected and ASPNET_DB_USER is selected from alist. This is followed by the Privileges sections. There are two lists, one is Available Privileges which contains all the avaiable privileges except those on the right which are the Granted Privileges. There are arrows between the lists for clicking from one list to another.

At the end, are the following buttons: Preview SQL, OK, Cancel, Apply, and Help.


The graphic shows a grid titled Parameters. Under this are fields and Data as follows: Name:DEP_ID, Direction: IN, DATA TYP: NUMBER, and Value 60 from a list. The second data line is highlighted and has this EMPLOYEES_C , OUT, REF CURSOR, and for value it instructs you to <Click here for Details.>

A separate grid below this shows the results of the query in the highlighted line, activated when you hit <Click here for Details.>


This screen shot starts with Configure the Select Statement. It asks "How would you like to retrieve data from your database?" and provides two options. One is Specify a custom SQL statement or store procedure, Second is Specify columns from a table or view with a list of the Names of tables or views. The name EMPLOYEES appears. Under this are columns to select. Currently the asterisk (*) is selected. Other columns include EMPLOYEE_ID, FIRST_NAME, LAST_NAME and etc.

Below this is the select statement as described in the text. There are buttons for Previous, Next, Finish, and Cancel.


The graphic displays the Summary window, indicating the Global Settings such as Oracle Base: E:\app\Oracle, Product Languages, Space Requirements, and New Installations. There are Help, Installed Products..., Back, Next, Install, and Cancel buttons.


This screen shot shows the Data Source Configuration wizard. You are requested to choose a Data Source type, of the following Access Database, Database, LINQ, Object, Site Map and XML file. Database is highlight. When this is chosen, under the list it says "Connect to any SQL database supported by ADO.NET, such as Microsoft SQL Server, Oracle, or OLEDB." After this is a field for entering an ID for the data source, which is HR. Finally, there are OK and Cancel buttons.


This shot shows the GridView again, only now instead of Column01 etc, it shows column names such as EMPLOYEE_ID, FIRST_NAME, etc from the EMPLOYEES table. The GridView Tasks page is shown listing some of the possible tasks. There ar check boxes for Enable Paging (checked), Enable Sorting (unchecked), and Enable Selection (unchecked).


The graphic shows the Build menu with commands such as Build Solution, Rebuild Solution, Clean Solution, and Batch Build.


The graphic shows a form with a Connect button and the following fields and entries, User ID:hr, Password:*********, Data Source orcl and a grid showing DEPARTMENT_ID, DEPARTMENT_NAME, MANAGER_ID, AND LOCATION_ID. the first line is 10, Administration, 200, and 1700. The second line is 20, Marketing, and so on. The last line is 5, Community Outreach, blank and 1700. It is still being entered.


The graphic shows the Solution Explorer, which has a tree structure. The first branch is Properties, then References, which is expanded to show Oracle.DataAccess, System, and many other.


The graphic shows the Solution Explorer for the HR_CONNECT_CS project with Form2.cs selected and expanded. The context menu is open showing commands such as Open, Open With..., View Class Diagram, Include in Project, and so on


This screen shot shows the Website menu and at the bottom, the highlighted ASP.NET Configuration.


This screen shot shows the Provider page, with two links: Select a single provider for all site management, and Select a different provider for each feature (advanced.


This screen shot shows the Add New Access Rule section. Under it are several parts. First there is a Select directory for this rule: This shows the tree view of WebSite1 expanded to show the App_Data folder. The second part is Rule applies to: with options to choose Role (includes a list) and User (includes an entry field). After that there is a link to Search for users. Below that are options to choose All users or Anonymous users. The last part is Permission: with option for All and Deny (selected). Last is the OK button.


Figure shows the Server Explorer tree, with SYS.ORCL, and the menu open to highlight Privileges...


The graphic shows the following: ERROR at line:

ORA-00946: table or view does not exist.


This screen shot shows the Manage Access Rules section with a tree view of WebSite1 that is expanded to show the App_Data folder. Besides the tree view is a panel that shows the rule: Permission: allow, for User and Roles: all, for Delete.

Below that is a link to Add new access rule


The graphic is described in the preceding text.


This window requests that you chose the dependent assemblies that should be copied over to the database. It lists the following assemblies: mscorlib, Oracle.DataAccess, System, and System.Data.

Then it requests the destination of the bin/clr directory, if it is not the default bin/clr directory. For this demonstration, the field is blank.

Then there is a check box where you can chose overwrite the file if it already exists.

There are buttons for Back, Next, Finish, or Cancel.


This screen shot shows the Properties Windows, including DestinationPageUrl, which is selected. Below that is another window, Select URL. It shows the contents of the Project folder, including Default.aspx (which should be selected) as well as login.aspx and web.config.


The graphic shows a code window for HR_Connect_CS.Form1 with these lines:


public Form1()
{
     InitializeComponent();
     Save.Enabled = false;
     date_change.Enabled = false;
}
private OracleGlobalization si;
private OracleConnection conn = new OracleConnection();
private OracleCommand cmd;



The graphic says the following. "Your project currently has no data sources associated with it. Add a new data source, then data-bind items by dragging from this window on forms or existing controls." Then there is a link labeled Add New Data Source.


The graphic shows the menu that appears. It contains the commands: View Code, Bring to Front, Send to Back, Lock Controls, and others.


This screen shot shows the Security page which was previously shown., however, now the Users heading has the following under it: Existing Users: 1 (where it previously said 0, and two links, Create user and Manage users.


The graphic shows the two options described in the text. It has the following buttons: Product Languages, Help, Back, Next, Install, and Cancel.


The graphic shows the Server Explorer, the HR.ORCL connection expanded, and Tables highlighted to display the menu. The menu lists New Relational Table..., New Object Table..., New XML Table..., Import Table..., Query Window, Privileges..., Refresh, and Properties.


The graphic shows a code window for HR_Connect_CS.Form1 with these lines:


public Form1()
{
     InitializeComonent();
     Save.Enabled = false;
     date_change.Enabled = false;
}



This graphic shows the command indicated in the text, and the typical response that indicates SQL*Plus has started, release number and copyright information. Next there is the password input request as described. Then the response "Connected to: Oracle Database ......Edition Release. The line after that shows the SQL*Plus prompt: SQL>.


The graphic is described in the preceding text. Under Choose a Data Source Type there is a field labeled Where will the application get data from? There are icons for selection, labeled, Database, Service, and Object. Below that field, is an area that describes each of the icons in turn when you select them. The database icon is currently highlighted with this description. "Lets you connect to a database and choose the database objects for your application. This option creates a dataset." Then there are Previous, Next, Finish, and Cancel buttons.


The graphic shows Form1 with an empty grid, with these columns showing: LAST_NAME, FIRST_NAME, BIRTH_DATE, RELATIONSHIP, EMPLOYEE_ID, and DEPENDENT_ID. Under that are labeled icons for the components listed in the text.


The graphic shows a form with a Connect button and the following fields and entries, User ID:hr, Password:*********, Data Source orcl and a grid showing DEPARTMENT_ID, DEPARTMENT_NAME, MANAGER_ID, AND LOCATION_ID. the first line is 10, Administration, 200, and 1700. The second line is 20, Marketing, and so on to 50.


This screen shot is named Add New Item - C:\HR_Projects\WebSite1|. There is a heading Templates: and a list of Visual Studio Installed templates, including Web Form, Web User Control, Master Page, and others/

Below these is the Name field with login.aspx entered. Then there's the Language field, with Visual C# selected from the list. There are two check boxes: Place code in separate file (checked) and Select master page (unchecked). Last are the Add and Cancel buttons.


The graphic illustrates this step of the procedure, as described in the preceding text.


The graphic shows the Solution Explorer for the HR_CONNECT_CS project with Form1.cs selected and expanded. The context menu is open showing commands such as Open, Open With..., View Class Diagram and so on.


The graphic shows the Properties window with Text highlighted and the text property as User ID.


This screen shot shows the ORACLE_BASE\\ORACLE_HOME\ASP.NET\sql directory with the InstallAllOracleASPNETProviders.sql file highlighted to open.


The graphic displays the declarations section for a C# application, with the two using statements described in the text, plus many others.


The graphic displays the Microsoft Visual Studio Start window. It contains in the upper left, a Recent Projects section, middle left, a Getting Started section, lower left Visual Studio Headlines section, middle a Visual Studio Developer News page, upper right, the Solution Explorer, and the Properties window.


This window requests that you specify your deployment option. The options are to: Copy assembly and generate stored procedures (selected), copy assembly only, or generate stored procedures only.

There are the following buttons: Back, Next, Finish (which is grayed out), and Cancel.


The graphic shows a grid titled Parameters. Under this are fields and Data as follows: Name:DEP_ID, Direction: IN, DATA TYP: NUMBER, and Value 60 from a list. The second data line has this EMPLOYEES_C , OUT, REF CURSOR, and for value it instructs you to <Click here for Details.>. The third line is highlighted and it has data: DEPENDENTS_C, OUT, REF CURSOR and the value Click here for Details.>

A separate grid below this shows the results of the query in the highlighted line, activated when you hit <Click here for Details.>


The graphic shows the Server Explorer tree with HR.ORCL expanded. Under Packages HR.DATA is selected and the context menu displayed. It shows commands to Edit Package Specification, Edit Package Body..., Compile, Compile Debug and so on.


This screen shot requests the connection string to the Application configuration file. First this is a check box labeled Yes, save this connection as: ConnectionString is entered in this field. Below this are buttons for Previous, Next, Finish, and Cancel.


The graphic shows employees with ID below 105. The columns and first line of data are: ID:100, Name, S. King, Short Hire: 6/17/1987, Long Hire Date, Wednesday, June 17, 1987.


The graphic shows a form with a Connect button and the following fields, User ID, Password, Data Source and Departments. There is one large unlabeled field.


This windows requests that you specify method and security details.On the left, a text box shows available methods with the following checked: HR_DeployedStored_CS, and under that, Class1, and then Int32 GetDepartmentNo.On the right is the title Methods Details, followed by Schema: with a drop-down list showing HR as the selected schema. After that, is a text field for Database method that shows GETDEPARTMETNTNO.After that, there is a button labeled Parameter Type Mapping... which goes to that screen.

After that, there is a drop-down list to set Security. The default level, Safe is entered.There are buttons to go Back, Next, Finish, and Cancel.


This is a screen shot of the Design.aspx from the design view. The main window shows a dotted rectangle containing the words "Employees List."


The graphic shows the project types on the left with Database under Visual C# highlighted. On the right, under Visual Studio installed templates, Oracle Project is highlighted. At the bottom, there are fields with Name, Location, Solution as described in text. Location has a browse box. There is a checked box for Create directory for solution, and an unchecked box for Add to Source Control. At the end are Ok and Cancel buttons.


The screenshot shows the query window with the SQL command "create user aspnet_db_user identified by your_password. A query results window below indicates: "The command(s) successfully completed.


This screen shot shows the Visual Studio menu, with File, then New expanded to show Project..., Web Site..., File..., and Project from Existing Code...


This screen shot is named New Web Site. There is a heading Templates: and a list of Visual Studio Installed templates, including ASP.NET Web Site, ASP.NET Web Service, Empty Web Site, and others, and My Templates including Search online Templates...

Below these lists are Location: with File System and C:\HR_Projects\WebSite selected from the lists. Then there's a Browse button, and after than the Language field, with Visual C# selected from the list. Last are the OK and Cancel buttons.


The graphic shows the Designer for Tables, as described. the Columns list has increased. It includes: Last_name, plus First_Name, Birth_date, Relationship, Employee_ID, and Dependent_ID. In the Column Properties, there is Name: Dependent_ID and Data Type Number, Default is blank, The Allow null box is unchecked, Size is 5 and Length semantic is selected as 0.


The graphic is described in the preceding text.


The graphic displays the fields described in the preceding text. The project types are on the left, templates on the right. There is a Browse button to determine the location of the project, check boxes to Create directory for solution and Add to Source Control There are OK and Cancel buttons.


The graphic is described in the preceding text.


The graphic shows the Toolbox with many of its controls. The first is All Windows Forms, which is collapsed, followed by Common Controls, which is expanded and shows the Pointer, Button, CheckBox, Label, ListBox and many other controls.


The graphic is described in the preceding text.


The graphic shows employees with ID below 105. The column labels and first data line are: EMPLOYEE_ID, FIRST_NAME: Steven, LAST_NAME: KING, and Hire Date: 1987-06-17.


Screen shot shows the Toolbox with Data group expanded and GridView highlighted.


The graphic lists the current destination folder for .NET products. It contains a Browse button for changing the path, Help, Installed Products..., Back, Next, Install, and Cancel buttons.


The graphic shows the Designer for Tables, as described. In the Columns list is the Name: Last_name and Data Type VARCHAR2. In the Column Properties, there is Name: Last_name and Data Type VARCHAR2, Default is blank, The Allow null box is check, Size is 30 and Length semantic is selected as Default.


This screen shot requests that you Choose Your Data Connection. There is a list and HR.ORCL is selection. There is also a button going to New Connection.

At the bottom, there are buttons for Previous, Next, Finish, and Cancel.


This screen shot shows the ASP.NET Web Site Administration Tool, which has Home, Security, Application and Provider tabs. The front home tab lists links to the other tabs.


This screen shot is much the same as last time as the time, except that it now contains the message described in the text and the address is again http://localhost:1451/WebSite1/login.aspx.


This window asks which data connection you want the wizard to use. The current connection SYS.ORCL is displayed.

There is a New Connection button.

There are buttons to go Back, Next, Finish, and Cancel.


The graphic contains the following code.


ALTER TABLE "DEPENDENTS" ADD (
 CONSTRAINT "EMPLOYEES_FK"
  FOREIGN KEY ("EMPLOYEEID")
   REFERENCES "EMPLOYEES" (EMPLOYEE_ID)
   ON DELETE CASCADE
  ENABLE
  VALIDATE);
ALTER TABLE "DEPENDENTS" ADD (
 CONSTRAINT "DEPENDENTS_PK"
  PRIMARY KEY("DEPENDENTID")
  USING INDEX "DEPENDENTS_INDEX"
  ENABLE
  VALIDATE);


There are buttons to Add to Project (disabled) and OK.


This is the Welcome window for the Oracle Deployment Wizard.

There is a box to select Do not show this page again.There are buttons to go Back, Next, Finish, and Cancel.


The graphic shows the Designer for Tables. At the top, is Schema Name, with HR selected from the list, then Table type with Relational indicated. There are four tabs: Columns, Constraints, Indexes, and Storage. The columns tab is selected. It contains a column area with the heading Name and Data Type, and Add and Remove buttons below. there are up and down arrows to change the order of the columns. to the right of this is the Column Properties Area with fields to enter Name, Data Type and Default. The bottom contains Preview SQL and Save buttons.


This screen shot shows the Address, which still ends in Default.aspx, but has changed to http://localhost:1451/WebSite1/login.aspx?ReturnUrl= %2fWebSite1%2fDefault.aspx. The actual page is the same as the previous one.


This screen shot shows the Test Query. It starts with "To preview the data returned by this data source, click Test Query. To complete this wizard, click Finish."

Below this, there is a blank field. After that, there is a Test Query button, followed by the SELECT statement described in the text.

There are buttons for Previous, Next, Finish, and Cancel.


This screen shots show the Visual Studio View Menu, including Code, Designer Markup and others. At the bottom of the menu, the Toolbox selection is highlighted.


The graphic is described in the preceding text.


This graphic shows a list of data sources including Oracle Database which is highlighted. Below this is a list for Data provider with Oracle Data Provider for .NET displayed. There is a check box to Always use this selection, and then OK and Cancel buttons.


The graphic shows salaries for employees with ID below 105. The columns and first line of data are: ID:100, Name, S. King, Salary: 24.005,00.
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6 Using PL/SQL Stored Procedures and REF CURSORs

This chapter contains:

	
Introduction to PL/SQL Stored Procedures


	
Introduction to PL/SQL Packages and Package Bodies


	
Introduction to REF CURSORs


	
Creating a PL/SQL Stored Procedure that Uses REF CURSORs


	
Modifying an ODP.NET Application to Run Stored Procedures


	
Running a PL/SQL Stored Procedure Using an ODP.NET Application






Introduction to PL/SQL Stored Procedures

A stored procedure is a named set of PL/SQL statements designed to perform an action. Stored procedures are stored inside the database. They define a programming interface for the database rather than allowing the client application to interact with database objects directly. Stored procedures are typically used for data validation or to encapsulate large, complex processing instructions that combine several SQL queries.

Stored functions have a single return value parameter. Unlike functions, procedures may or may not return values.






Introduction to PL/SQL Packages and Package Bodies

A PL/SQL package stores related items as a single logical entity. A package is composed of two distinct pieces:

	
The package specification defines what is contained in the package; it is analogous to a header file in a language such as C++. The specification defines all public items. The specification is the published interface to a package.


	
The package body contains the code for the procedures and functions defined in the specification, and the code for private procedures and functions that are not declared in the specification. This private code is only visible within the package body.




The package specification and body are stored as separate objects in the data dictionary and can be seen in the user_source view. The specification is stored as the PACKAGE type, and the body is stored as the PACKAGE BODY type.

While it is possible to have a specification without a body, as when declaring a set of public constants, it is not possible to have a body with no specification.






Introduction to REF CURSORs

Using REF CURSORs is one of the most powerful, flexible, and scalable ways to return query results from an Oracle Database to a client application.

A REF CURSOR is a PL/SQL data type whose value is the memory address of a query work area on the database. In essence, a REF CURSOR is a pointer or a handle to a result set on the database. REF CURSORs are represented through the OracleRefCursor ODP.NET class.

REF CURSORs have the following characteristics:

	
A REF CURSOR refers to a memory address on the database. Therefore, the client must be connected to the database during the lifetime of the REF CURSOR in order to access it.


	
A REF CURSOR involves an additional database round-trip. While the REF CURSOR is returned to the client, the actual data is not returned until the client opens the REF CURSOR and requests the data. Note that data is not be retrieved until the user attempts to read it.


	
A REF CURSOR is not updatable. The result set represented by the REF CURSOR is read-only. You cannot update the database by using a REF CURSOR.


	
A REF CURSOR is not backward scrollable. The data represented by the REF CURSOR is accessed in a forward-only, serial manner. You cannot position a record pointer inside the REF CURSOR to point to random records in the result set.


	
A REF CURSOR is a PL/SQL data type. You create and return a REF CURSOR inside a PL/SQL code block.









Creating a PL/SQL Stored Procedure that Uses REF CURSORs

This section demonstrates how to create a PL/SQL stored procedure.


To create a stored procedure:

	
Open Server Explorer and double-click HR to open the connection to the HR schema created in "Connecting to the Oracle Database".

[image: Description of connect_se.gif follows]




If you have not previously saved the password, the Oracle Server Login opens and you can enter the password now. If you have saved the password, then the connection expands immediately.


	
In Server Explorer, right-click Packages and select New Package.

[image: Description of procedure1.gif follows]




The New Package window appears.


	
In the New Package window, change the Package Name to HR_DATA.


	
Under the Methods area, click Add.

[image: Description of procedure2.gif follows]




The Add Method window appears.


	
In the Add Method window, enter Method Name GETCURSORS, and change Method Type to Procedure.


	
Under Parameters, click Add.

This starts the process of adding parameters.

Under the Parameter Details group on the right, enter these three parameters. Click Add before each parameter that you need to add.

	
Name: DEP_ID, Direction: select IN , Data Type: select NUMBER.


	
Name: EMPLOYEES_C, Direction: select OUT, Data Type: select SYS_REFCURSOR.


	
Name: DEPENDENTS_C , Direction: OUT, Data Type: select SYS_REFCURSOR.




[image: Description of procedure3.gif follows]




	
Click OK when you finish adding parameters.

The New Package window reappears.


	
In the New Package window, click Preview SQL to see the SQL code created.

A Preview SQL window appears, containing code similar to the following. Note that this code has been abbreviated by removing most of the comments.



CREATE PACKAGE "HR"."HR_DATA" IS  -- Declare types, variables, constants, exceptions, cursors, 
  -- and subprograms that can be referenced from outside the package.

  PROCEDURE "GETCURSORS" (
    "DEP_ID" IN NUMBER, 
    "EMPLOYEES_C" OUT SYS_REFCURSOR, 
    "DEPENDENTS_C" OUT SYS_REFCURSOR);

END "HR_DATA";

CREATE PACKAGE BODY "HR"."HR_DATA" IS

  -- Implement subprograms, initialize variables declared in package
  -- specification.

  -- Make private declarations of types and items, that are not accessible 
  -- outside the package
   PROCEDURE "GETCURSORS" (
    "DEP_ID" IN NUMBER, 
    "EMPLOYEES_C" OUT SYS_REFCURSOR, 
    "DEPENDENTS_C" OUT SYS_REFCURSOR) IS

  -- Declare constants and variables in this section.

     BEGIN -- executable part starts here

     NULL;

  -- EXCEPTION -- exception-handling part starts here
 
    END "GETCURSORS";

END "HR_DATA"; 


	
Click OK to close the Preview SQL window.


	
In the New Package window, click OK to save the new package.

The new package, HR_DATA, now appears in the Server Explorer.


	
In the Server Explorer, right-click the package HR_DATA, and select Edit Package Body.

[image: Description of procedure4.gif follows]




The code for the package appears.


	
Scroll down to the body of the GETCURSORS procedure, and after BEGIN, replace the line NULL; with the following code:



OPEN EMPLOYEES_C FOR SELECT * FROM EMPLOYEES 
   WHERE DEP_ID=DEPARTMENT_ID;
OPEN DEPENDENTS_C FOR SELECT * FROM DEPENDENTS;


	
Save the changes to the package.


	
To run the stored procedure, in Server Explorer, expand the HR_DATA package.

Right-click the GETCURSORS method, and select Run.

[image: Description of procedure5.gif follows]




The Run Procedure window appears.


	
In the Run Procedure window, enter a Value of 60 for dep_id.

[image: Description of procedure6.gif follows]




	
Click OK.

The Output window appears, showing that the run was successful.

In the result window, the following message appears:


Procedure <HR.HR_DATA.GETCURSORS@hr.database> was run successfully.


Under this message, note two output parameters (together with DEP_ID): EMPLOYEES_C and DEPENDENTS_C.


	
Select the Value column entry for EMPLOYEES_C.

The Parameter Details area appears, showing the employees in department 60. The value for DEP_ID is 60.

[image: Description of procedure7.gif follows]




	
Select the Value column entry for DEPENDENTS_C.

The Parameter Details area appears, showing the value of the DEPENDENTS_C.

[image: Description of procedure8.gif follows]











Modifying an ODP.NET Application to Run Stored Procedures

This section demonstrates how to modify your Oracle Data Provider for .NET application to run a PL/SQL stored procedure, using the GETCURSORS stored procedure as a sample.


To modify your application to run a stored procedure:

	
Open the application HR_Connect_CS or HR_Connect_VB.


	
Make a copy of Form3.xx, which you finished at the end of Chapter 4 and name it Form4.xx, following the instructions in Appendix B, "Copying a Form".


	
With Form1 selected, switch to code view.


	
In the try block of the connect_Click() method, replace the two command assignment lines, starting with cmd = New OracleCommand... with the code indicated.

Visual C#:


cmd = new OracleCommand("HR_DATA.GETCURSORS", conn);
cmd.CommandType = CommandType.StoredProcedure;


Visual Basic:


cmd = new OracleCommand("HR_DATA.GETCURSORS", conn)
cmd.CommandType = CommandType.StoredProcedure


	
Under the code added in Step 3, add definitions and bindings for the three parameters of the GETCURSORS stored procedure as OracleParameter objects, calling them dep_id, employees_c and dependents_c.

Visual C#:


OracleParameter dep_id = new OracleParameter();
dep_id.OracleDbType = OracleDbType.Decimal;
dep_id.Direction = ParameterDirection.Input;
dep_id.Value = 60;
cmd.Parameters.Add(dep_id);

OracleParameter employees_c = new OracleParameter();
employees_c.OracleDbType = OracleDbType.RefCursor;
employees_c.Direction = ParameterDirection.Output;
cmd.Parameters.Add(employees_c);

OracleParameter dependents_c = new OracleParameter();
dependents_c.OracleDbType = OracleDbType.RefCursor;
dependents_c.Direction = ParameterDirection.Output;
cmd.Parameters.Add(dependents_c);


Visual Basic:


Dim dep_id As OracleParameter = New OracleParameter
dep_id.OracleDbType = OracleDbType.Decimal
dep_id.Direction = ParameterDirection.Input
dep_id.Value = 60
cmd.Parameters.Add(dep_id)

Dim employees_c As OracleParameter = New OracleParameter
employees_c.OracleDbType = OracleDbType.RefCursor
employees_c.Direction = ParameterDirection.Output
cmd.Parameters.Add(employees_c)

Dim dependents_c As OracleParameter = New OracleParameter
dependents_c.OracleDbType = OracleDbType.RefCursor
dependents_c.Direction = ParameterDirection.Output
cmd.Parameters.Add(dependents_c)


	
Build the application.









Running a PL/SQL Stored Procedure Using an ODP.NET Application

This section demonstrates how to run a PL/SQL stored procedure, such as the GETCURSORS stored procedure, from your ODP application.


To run a stored procedure:

	
Run the application.

A Form1 window appears.


	
In the Form1 window, enter the connection information, and click Connect.


	
In the DataGrid object, scroll horizontally to verify that the values in the last column, DEPARTMENT_ID are only 60.

Note that the DataGrid contains the first result set from the stored procedure, which matches the query of the EMPLOYEES table.

[image: Description of procedure9.gif follows]




	
Close the application.
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8 Developing and Deploying .NET Stored Procedures

This chapter contains:

	
Overview of .NET Stored Procedures


	
Starting the Common Language Runtime Service


	
Creating a Connection as SYSDBA


	
Creating an Oracle Project


	
Creating .NET Stored Functions and Procedures


	
Deploying .NET Stored Functions and Procedures


	
Running .NET Stored Functions and Procedures


	
Running .NET Stored Procedure in a Query Window






Overview of .NET Stored Procedures

.NET stored procedures are methods or procedures written in a .NET language which contains SQL or PL/SQL statements.

You can write custom stored procedures and functions using any .NET compliant language, such as C# and VB.NET, and use these .NET stored procedures in the database, in the same manner as other PL/SQL or Java stored procedures. .NET stored procedures can be called from PL/SQL packages, procedures, functions, and triggers; from SQL statements, or from anywhere a PL/SQL procedure or function can be called.

Oracle Database Extensions for .NET (a database option that allows you to write .NET stored procedures) must be installed and configured in the database to run the examples in this chapter.

This chapter discusses how to use and deploy .NET stored procedures in your application.






Starting the Common Language Runtime Service

To use .NET stored procedures, you must first start the common language runtime agent, represented by the OraClrAgent service. This service may not start by default. Note that it is located on the Oracle database, not on the client.




	
Note:

OraClrAgnt can be accessed through the Services Control Panel, as OracleOracleHomeNameClrAgnt, where OracleHomeName represents your Oracle home.








To start the common language runtime service:

	
From the Start menu, select All Programs, then select Administrative Tools, and finally, select Services.


	
In the Services window, click the Extended tab.

Scroll down the list of Services, and select OracleOracleHomeNameClrAgnt.


	
Click the Start hyperlink.

The Service Control window shows that the OracleClrAgent is starting.


	
When the Service Control window closes, note that the status of the OracleClrAgent is changed to Started.









Creating a Connection as SYSDBA

Next, you must create a database connection as SYSDBA which enables you to deploy your Oracle Project.




	
Note:

You must have administrative privileges as SYSDBA to perform this task.










	
Note:

To use the Enterprise Manager to set the sys account password, see About Administrative Accounts and Privileges in the Oracle Database 2 Day DBA.








To create a database connection in ODT:

	
From the View menu, select Server Explorer.


	
In Server Explorer, right-click Data Connections.


	
Select Add Connection.


	
When the Add Connection window appears, determine if the Data source says Oracle Database (Oracle ODP.NET).

If it does, skip to Step 6.

[image: Description of addconnection1a.gif follows]




If Data source does not say Oracle Database (Oracle ODP.NET), select Change.

The Change Data Source window appears.

[image: Description of addconnection2a.gif follows]




	
Choose Oracle Database and then select Oracle Data Provider for .NET.


	
In the Add Connection window, use the following:

	
For User name, enter sys.


	
For Password, enter the password set by the administrator who unlocked and set up the sys account.

To use the Enterprise Manager to set the sys account password, see About Administrative Accounts and Privileges in the Oracle Database 2 Day DBA.


	
Ensure that the Role is set to Sysdba.

The Connection name is generated automatically from the Data source name and the User name values.

[image: Description of deploy03.gif follows]







	
In the Add Connection window, click OK

The Server Explorer window should now contain the SYS.ORCL connection.









Creating an Oracle Project

To use stored procedures in .NET, you must first create a new Oracle Project to hold the stored procedures.


To create a project for .NET stored procedures:

	
From the File menu, select New, and then select Project.

A New Project dialog box appears.


	
In Project Types, select the type of project you are creating:

	
Visual C#:

Visual C# , then select Database, and under Templates:Oracle Project

Enter Name: HR_DeployStored_CS.


	
Visual Basic:

Other Languages, then select Visual Basic and Database, then under Templates: Oracle Project

Enter Name: HR_DeployStored_VB.





	
Enter Location: C:\HR_Projects.


	
Click OK.

[image: Description of deploy01.gif follows]











Creating .NET Stored Functions and Procedures

You are now ready to create a .NET stored procedure.


To create a .NET stored procedure:

	
In Solution View, select the Class1.cs or Class1.vb tab in your project.


	
Add these namespace directives for the specific language, as described in "Adding Namespace Directives".

Visual C#:


using Oracle.DataAccess.Client; 
using Oracle.DataAccess.Types;





Visual Basic:


Imports Oracle.DataAccess.Client 
Imports Oracle.DataAccess.Types


	
Add Reference to Oracle.DataAccess.dll as described in "Adding a Reference".


	
Copy the getDepartmentno() method into the Class1 declaration, as indicated

Visual C#



public static int getDepartmentno(int employee_id)
{
  int department_id = 0;

  // Get a connection to the db
  OracleConnection conn = new OracleConnection();
  conn.ConnectionString = "context connection=true";
  conn.Open();

  // Create and execute a command
  OracleCommand cmd = conn.CreateCommand();
  cmd.CommandText = "select department_id from employees where employee_id = :1";
  cmd.Parameters.Add(":1", OracleDbType.Int32, employee_id,
    ParameterDirection.Input);
  OracleDataReader rdr = cmd.ExecuteReader();

  while(rdr.Read())
    department_id=rdr.GetInt32(0);

  rdr.Close();
  cmd.Dispose();

  // Return the employee's department number
  return department_id;
}


Visual Basic:



Public Shared Function getDepartmentno(ByVal employee_id As Integer) As Integer
  Dim department_id As Integer = 0 

  ' Get a connection to the db
  Dim conn As OracleConnection = New OracleConnection()
  conn.ConnectionString = "context connection=true"
  conn.Open()

  ' Create and execute a command
  Dim cmd As OracleCommand = conn.CreateCommand()
  cmd.CommandText = "select department_id from employees where employee_id = :1"
  cmd.Parameters.Add(":1", OracleDbType.Int32, employee_id,     ParameterDirection.Input)
  Dim rdr As OracleDataReader = cmd.ExecuteReader()

  While rdr.Read()
    department_id = rdr.GetInt32(0)

  End While

  rdr.Close()
  cmd.Dispose()

  ' Return the employee's department number
  Return department_id

End Function


[image: Description of deploy04.gif follows]




	
Save Class1.


	
From the Build menu, select Build Solution.

[image: Description of deploy05.gif follows]




	
Check that the Output window indicates a successful build and close it.









Deploying .NET Stored Functions and Procedures

You can now deploy the .NET stored procedure that you created "Creating .NET Stored Functions and Procedures".


To deploy a .NET stored procedure:

	
From the Build menu, select Deploy Solution.

[image: Description of deploy06.gif follows]




An Oracle Deployment Wizard for .NET window appears.


	
In the Oracle Deployment Wizard for .NET window, click Next.

[image: Description of deploy07.gif follows]




	
On the Configure your OracleConnection window, click Next.

[image: Description of deploy08.gif follows]




	
On the Specify your deployment option window, ensure that the first option, Copy assembly and generate stored procedures is selected, and click Next.

[image: Description of deploy10.gif follows]




	
On the Specify an assembly and library name window, accept the defaults and click Next.

[image: Description of deploy11.gif follows]




	
On the Specify copy options window, accept the defaults and click Next.

Visual Basic:

If you are using Visual Basic, the Microsoft.VisualBasic assembly also appears as a referenced assembly.

[image: Description of deploy12.gif follows]




	
On the Specify methods and security details window, under Available methods, expand HR_DeployStored_CS or HR_DeployStored_VB, then expand Class1, and select the getDepartmentno() method.

Under Method Details, select HR from the Schema list.

Click Next.

[image: Description of deploy13.gif follows]




	
On the Summary window, click Finish.

[image: Description of deploy14.gif follows]











Running .NET Stored Functions and Procedures

You are now ready to run the .NET stored procedure you deployed earlier.


To run a .NET stored procedure:

	
In Server Explorer, open and expand the HR.ORCL connection. Expand Functions. Right-click GETDEPARTMENTNO and select Run.

[image: Description of deploy15.gif follows]




The Run Function window appears.


	
In the Run Function window, enter a Value of 100 for EMPLOYEE_ID.

Click OK.

[image: Description of deploy16.gif follows]




	
Note that the return value for department is 90, indicating that EMPLOYEE_ID 100 is in department 90.

[image: Description of deploy17.gif follows]











Running .NET Stored Procedure in a Query Window

You can run the .NET stored procedure that you have just created using the ODT Query Window, in addition to running it from Server Explorer.

	
Open the Server Explorer in the HR.ORCL schema.


	
Expand Functions and select GETDEPARTMENTNO.


	
Right-click and select Query Window.


	
Enter Select getdepartmentno(100) from dual.


	
Click Execute from the toolbar.

[image: Description of querywindow.gif follows]
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9 Including Globalization Support

This chapter contains:

	
Introduction to Global Applications


	
Developing Global Applications with the .NET Framework


	
Presenting Data in the Correct User Local Convention


	
Synchronizing the .NET and Oracle Database Locale Environments


	
Client Globalization Support in Oracle Data Provider for .NET







	
See Also:

	
Chapter 8, "Oracle Data Provider for .NET Globalization Classes" in Oracle Data Provider for .NET Developer's Guide


	
"Working in a Global Environment" in the Oracle Database 2 Day Developer's Guide


	
Microsoft .NET Internationalization Internet site, http://msdn.microsoft.com/en-us/goglobal/bb688096.aspx














Introduction to Global Applications

This chapter discusses global application development with Oracle Database in .NET. It addresses the basic tasks associated with developing applications that are ready for global deployment, such as developing locale awareness and presenting data with cultural conventions of the user's locale. It also discusses globalization support features available in Oracle Data Provider for .NET.

Building a global-ready application that supports different locales requires good development practices.

A locale refers to a national language and the region in which the language is spoken. The application itself must be aware of the user's locale preference and be able to present content following the cultural convention expected by the user. It is important to present data with appropriate locale characteristics, such as the correct date and number formats. Oracle Database is fully internationalized to provide a global platform for developing and deploying global applications.






Developing Global Applications with the .NET Framework

When planning a global-ready application, you have to consider two main tasks:

	
Globalization is the process of designing applications that can adapt to different cultures.


	
Localization is the process of translating resources for a specific culture.




In the .NET Framework, the System.Globalization namespace contains classes that define information related to culture, such as language, country and region, calendars, format patterns for dates, currency, and numbers, and the sort order for strings. These classes simplify the process of developing a global-ready application, so that passing a CultureInfo object that represents the user's culture to methods in System.Globalization namespace initiates the correct set of rules and data.

The .NET Framework also supports the creation and localization of resources, and offers a model for packaging and deploying them. Localizing the application's resources for specific cultures supports development of translated versions of the application. The .NET Framework base class library provides several classes in the System.Resources namespace for building and manipulating application resources.






Presenting Data in the Correct User Local Convention

Data in the application must be presented in a way that meets the user's expectations, or its meaning can be misinterpreted. For example, 12/11/05 implies December 11, 2005 in the United States and November 12, 2005 in the United Kingdom. Similar confusion exists for number and monetary formats. For example, the period (.) is a decimal separator in the United States and a thousand separator throughout Europe.

Different languages have their own sorting rules: some languages are collated according to the letter sequence in the alphabet, others according to stroke count in the letter, still others are ordered by the pronunciation of the words. Presenting data that is not sorted according to the linguistic sequence that the user is accustomed to can make searching for information difficult and time-consuming.

Depending on the application logic and the volume of data retrieved from the database, it may be more appropriate to format the data at the database level rather than at the application level. Oracle Database offers many features that refine the presentation of data when the user locale preference is known.



Connecting to SQL*Plus

Several of the following examples require that you use SQL*Plus to connect as a user with database administrator privileges such as SYS or SYSTEM.




	
See Also:

"Locking and Unlocking User Accounts" in the Oracle Database 2 Day DBA for further information












Using Oracle Date Formats

There are three different date presentation formats in Oracle Database: standard, short, and long. The following steps illustrate the difference between the short and long date formats for United States and Germany.


To change the Oracle date format:

	
From a Windows command prompt, enter the following


  C:\>sqlplus "sys as sysdba"
Enter password:passwd


where passwd is the Sys password that was established when the database was installed. The password does not appear when you type the characters. [image: Description of nls00.gif follows]






	
Enter this command at the SQL prompt:



SQL> ALTER SESSION SET NLS_TERRITORY=america NLS_LANGUAGE=american;


This message appears: Session altered.

There is no problem with setting a parameter to its current setting. You may want to do this for security. To determine what your current settings are enter:


SQL> select * from v$nls_parameters;  


or


select * from v$nls_parameters where parameter = 'NLS_LANGUAGE';


	
At the SQL prompt, enter the following query:



SQL> SELECT employee_id "ID",
  SUBSTR (first_name,1,1)||'. '||last_name "Name",
  TO_CHAR (hire_date, 'DS') "Short Hire",
  TO_CHAR (hire_date, 'DL') "Long Hire Date"
  FROM hr.employees
  WHERE employee_id < 105;


Note that you must use hr.employees in order to access the employees table in the hr schema because you are currently logged in as sys, not hr.

The result of the query returns in the American format specified in Step 1.

[image: Description of nls01.gif follows]




	
Enter the following command at the SQL prompt:



SQL> ALTER SESSION SET NLS_TERRITORY=germany NLS_LANGUAGE=german;


This message appears: Session altered.


	
At the SQL prompt, enter the query from Step 3.

The result of the query returns in the German format specified in Step 4.

[image: Description of nls02.gif follows]











Using Oracle Number Formats

There are also differences in the decimal character and group separator. The following steps illustrate these difference between United States and Germany.


To change the Oracle number format:

	
Enter the following command at the SQL prompt:



SQL> ALTER SESSION SET NLS_TERRITORY=america NLS_LANGUAGE=american;


This message appears: Session altered.


	
At the SQL prompt, enter the following query:



SQL> SELECT employee_id "ID",
  SUBSTR (first_name,1,1)||'. '||last_name "Name",
  TO_CHAR (salary, '99G999D99') "Salary"
  FROM hr.employees
  WHERE employee_id < 105;


The result of the query returns in the American format specified in Step 1.

[image: Description of nls03.gif follows]




	
Enter the following command at the SQL prompt:



SQL> ALTER SESSION SET NLS_TERRITORY=germany;


This message appears: Session altered.


	
At the SQL prompt, enter the query in Step 2.

The result of the query returns in the German format specified in Step 3.

[image: Description of nls04.gif follows]











Using Oracle Linguistic Sorts

Spain traditionally treats ch, ll, and ñ as letters of their own, ordered after c, l and n, respectively. The following steps illustrate the effect of using a Spanish sort against the employee names Chen, Chung, and Colmenares.


To change the Oracle linguistic sort:

	
Enter the following command at the SQL prompt.



SQL> ALTER SESSION SET NLS_SORT=binary;


This message appears: Session altered.


	
At the SQL prompt, enter the following query:



SQL> SELECT employee_id "ID",
          last_name "Name"
  FROM hr.employees
  WHERE last_name LIKE 'C%'
  ORDER BY last_name;


The result of the query returns in the binary sort specified in Step 1.

[image: Description of nls05.gif follows]




	
Enter the following command at the SQL prompt.



SQL> ALTER SESSION SET NLS_SORT=spanish_m;


This message appears: Session altered.


	
At the SQL prompt, enter the query in Step 2.


	
The result of the query returns in the Spanish sort specified in Step 3.

[image: Description of nls06.gif follows]











Oracle Error Messages

The NLS_LANGUAGE parameter also controls the language of the database error messages. Setting this parameter prior to submitting a SQL query ensures the return of local language-specific error messages, as shown in these steps:


To change the Oracle NLS language parameter:

	
Enter the following command at the SQL prompt.



SQL> ALTER SESSION SET NLS_LANGUAGE=american;


This message appears: Session altered.


	
At the SQL prompt, enter the following query.



SQL> SELECT * FROM managers;


The result of the query return the error message in the language specified in Step 1.

[image: Description of nls07.gif follows]




	
Enter the following command at the SQL prompt.


SQL> ALTER SESSION SET NLS_LANGUAGE=french;


This message appears: Session altered.


	
At the SQL prompt, enter the query in Step 2.

The result of the query returns the error message in the language specified in Step 3.

[image: Description of nls08.gif follows]




	
Reset your language, local, and sort settings back to their original values.











Synchronizing the .NET and Oracle Database Locale Environments

When you are developing global applications, always synchronize the user locale settings between the database and clients. Otherwise, the application may present conflicting culture-sensitive information. For example, a .NET application must map the Culture ID of the application user to the correct NLS_LANGUAGE and NLS_TERRITORY parameter values before performing SQL operations.

Table 9-1 shows some of the more common locales, as defined in .NET and Oracle environments.


Table 9-1 Common NLS_LANGUAGE and NLS_TERRITORY Parameters

	Culture	Culture ID	NLS_LANGUAGE	NLS_TERRITORY
	
Chinese (P.R.C.)

	
zh-CN

	
SIMPLIFIED CHINESE

	
CHINA


	
Chinese (Taiwan)

	
zh-TW

	
TRADITIONAL CHINESE

	
TAIWAN


	
English (U.S.A.)

	
en-US

	
AMERICAN

	
AMERICA


	
English (U.K.)

	
en-GB

	
ENGLISH

	
UNITED KINGDOM


	
French (Canada)

	
fr-CA

	
CANADIAN FRENCH

	
CANADA


	
French (France)

	
fr-FR

	
FRENCH

	
FRANCE


	
German

	
de

	
GERMAN

	
GERMANY


	
Italian

	
it

	
ITALIAN

	
ITALY


	
Japanese

	
ja

	
JAPANESE

	
JAPAN


	
Korean

	
ko

	
KOREAN

	
KOREA


	
Portuguese (Brazil)

	
pt-BR

	
BRAZILIAN PORTUGUESE

	
BRAZIL


	
Portuguese

	
pt

	
PORTUGUESE

	
PORTUGAL


	
Spanish

	
es

	
SPANISH

	
SPAIN












Client Globalization Support in Oracle Data Provider for .NET

Oracle Data Provider for .NET enables applications to manipulate culture-sensitive data, such as ensuring proper string format, date, time, monetary, numeric, sort order, and calendar support using culture conventions defined in the Oracle Database. The default globalization settings are determined by the client's NLS_LANG parameter, which is defined in the Windows Registry of the local computer. When the OracleConnection Open method establishes a connection, it implicitly opens a session with globalization parameters specified by the value of the NLS_LANG parameter.



Client Globalization Settings

The client globalization parameter settings are read-only and remain constant throughout the lifetime of the application. Changing the OracleGlobalization object properties does not change the globalization settings of the session or the thread. The following sections describe how to modify the globalization settings at the session and thread level.

Your .NET application can obtain globalization settings by calling the OracleGlobalization.GetClientInfo() static method. The OracleGlobalization sample code below demonstrates how to obtain some of the values in .NET.

Visual C#:



using System;
using Oracle.DataAccess.Client; 
 
class ClientGlobalizationSample
{
  static void Main()
  {
    OracleGlobalization ClientGlob = OracleGlobalization.GetClientInfo();
    Console.WriteLine("Client machine language: " + ClientGlob.Language);
    Console.WriteLine("Client characterset: " + ClientGlob.ClientCharacterSet);
  }
}


Visual Basic:



Imports System
Imports Oracle.DataAccess.Client
 
Class ClientGlobalizationSample
  Shared Sub Main()
    Dim ClientGlob As OracleGlobalization = OracleGlobalization.GetClientInfo()
    Console.WriteLine("Client machine language: " + ClientGlob.Language)
    Console.WriteLine("Client characterset: " + ClientGlob.ClientCharacterSet)
  End Sub
End Class






Using Session Globalization Settings

Session globalization parameters are initially identical to client globalization settings, but they can be modified. To modify the session parameters, you must establish a connection to the database, and then call the GetSessionInfo() method of an OracleConnection object to retrieve the session globalization settings. Next, you modify the globalization settings as needed, then save the settings back to the OracleConnection object through the SetSessionInfo(OracleGlobalization) method.


To specify the globalization session setting:

	
Open the application HR_Connect_CS or HR_Connect_VB.


	
Make a copy of Form3.xx, which you finished at the end of Chapter 4 and name it Form5.xx, following the instructions in Appendix B, "Copying a Form".


	
Open Form1 of the project, and switch to design view.


	
From the View menu, select Toolbox.


	
From the Toolbox, under Windows Forms, drag and drop a Button onto Form1.


	
Right-click the new Button, select Properties. The Properties window appears.


	
In the Properties window, set these properties:

	
Under Appearance, change Text to Change Date Format.


	
Under Design, change (Name) to date_change.

Form1 should look much like this:

[image: Description of nls09.gif follows]






In the properties window, if you click Events (lightning bolt icon), date_change_Click() now shows as the Event for the date button.


	
Open the new date_change_Click() method just created and add the following code to change the date format from the standard DD-MON-RR to YYYY-MM-DD and to update the DataSet.

Visual C#:



si.DateFormat = "YYYY-MM-DD";
conn.SetSessionInfo(si);
 
ds.Clear();
da.Fill(ds);
departments.DataSource = ds.Tables[0];


Visual Basic:



si.DateFormat = "YYYY-MM-DD"
conn.SetSessionInfo(si)
 
ds.Clear()
da.Fill(ds)
departments.DataSource = ds.Tables(0)


Note that the ds.Clear() call will clear the old results before posting the changed data.

Also, the si class variable will be declared and session globalization information retrieved in Step 10 and Step 11.


	
Within the appropriate method, add the code indicated.

Visual C#: In the Form1() method



date_change.Enabled = false;


Visual Basic: In the Form1_Load method



date_change.Enabled = false


[image: Description of nls10.gif follows]




	
Add the following class variable to the existing Form1 class declarations right after the public Form1() block with this code as indicated.

Visual C#:



private OracleGlobalization si;


Visual Basic:



private si As OracleGlobalization


[image: Description of nls11.gif follows]




	
Within the connect_Click() method try block, add the indicated code which does the following:

	
Retrieve the value of the OracleGlobalization object.


	
Retrieve data from the EMPLOYEES table (note the new query).


	
Enable the Change Date Format button.




The changed code is in bold typeface.

Visual C#:



conn.Open();
connect.Enabled = false;

si = conn.GetSessionInfo();
 
string sql = "select employee_id, first_name, last_name, TO_CHAR(hire_date)" +
   " \"Hire Date\" from employees where employee_id < 105";
cmd = new OracleCommand(sql, conn);
cmd.CommandType = CommandType.Text;

da = new OracleDataAdapter(cmd);
cb = new OracleCommandBuilder(da);
ds = new DataSet();
 
da.Fill(ds);
 
departments.DataSource = ds.Tables[0];
 
save.Enabled = true;
date_change.Enabled = true;


Visual Basic:



conn.Open()
connect.Enabled = false

si = conn.GetSessionInfo()

Dim sql As String = "select employee_id, first_name, last_name, " & _
    "TO_CHAR(hire_date) ""Hire Date"" from employees where employee_id < 105"
cmd = new OracleCommand(sql, conn)
cmd.CommandType = CommandType.Text

da = new OracleDataAdapter(cmd)
cb = new OracleCommandBuilder(da)
ds = new DataSet()
 
da.Fill(ds)
 
departments.DataSource = ds.Tables[0]
 
save.Enabled = true
date_change.Enabled = true


	
Save Form1.


	
Run the application using the F5 keyboard shortcut.

The application successfully connects to the database so the data grid is populated with the results of the query.

[image: Description of nls12.gif follows]




	
Click Change Date Format.

[image: Description of nls13.gif follows]




Note that the date format changed from the original DD-MON-RR to YYYY-MM-DD.


	
Close the application.









Thread-Based Globalization Settings

Thread-based globalization parameter settings are specific to each thread. Initially, these settings are identical to the client globalization parameters, but they can be changed programmatically. When converting ODP.NET Types to and from strings, use the thread-based globalization parameters, if applicable.

Thread-based globalization parameter settings are obtained by calling the GetThreadInfo() static method of the OracleGlobalization class. A call to SetThreadInfo() static method sets the globalization settings of the thread.

ODP.NET classes and structures rely solely on the OracleGlobalization settings when manipulating culture-sensitive data. They do not use .NET thread culture information. If the application uses only .NET types, OracleGlobalization settings have no effect. However, when conversions are made between ODP.NET Types and .NET Types, OracleGlobalization settings are used where applicable.




	
Note:

Changes to the System.Threading.Thread. CurrentThread.CurrentCulture property do not impact the OracleGlobalization settings of the thread or the session. The reverse is also true.
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A Starting and Stopping an Oracle Database Instance

You may need to frequently stop and restart the database.


To start an Oracle Database Instance:

	
From the Start button, select Programs, then Administrative Tools, then Services, and select OracleServiceDatabaseName where DatabaseName is the service_name of the database as indicated in the tnsnames.ora file. See "Configuring a NET Connect Alias" for further details.


	
In the left panel, click the link to Start the service.


	
The database services begin and the Start Database window appears. Do not proceed until you see this message: "OracleService service was started successfully".





To stop an Oracle Database Instance:

	
From the Start button, select Programs, then Administrative Tools, then Services, and select OracleServiceDatabaseName.


	
In the left panel, click the link to Stop the service.


	
The database begins to shut down, showing the Stop Database window. Do not proceed until you see this message: "OracleService service was stopped successfully".






[image: Oracle Corporation]
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7 Using ASP.NET with Oracle Database

This chapter contains:

	
Overview: Building an ASP.NET Application with Oracle Developer Tools


	
Before Beginning This Tutorial


	
Creating a Web Site and Connecting it to the Database


	
Enabling a Web Site for Authentication


	
Enabling Oracle Providers for ASP.NET and Creating a Lightweight Web User


	
Testing Web Site Authentication






Overview: Building an ASP.NET Application with Oracle Developer Tools

Oracle integrates directly with Microsoft ASP.NET in a number of ways:

	
Oracle Developer Tools for Visual Studio provides an easy way to design data-driven web sites.


	
ODP.NET enables ASP.NET data access.


	
Oracle Providers for ASP.NET integrate directly with Microsoft ASP.NET controls and services to provide state management capabilities for web sites.




This tutorial demonstrates some of these features, including how to build a data-driven web application using Oracle Developer Tools and how to add security to that application in a simple manner using Oracle Providers for ASP.NET.

First, you will use the tools to build a web application that retrieves employee data from the Oracle database into a data grid. Then, you add a login control and secure the application by permitting only authorized web users access to this employee information. Finally, you create authorized web users using Oracle Providers for ASP.NET. These web users are stored within the Oracle database for authentication by this application.






Before Beginning This Tutorial

Before you can build an ASP.NET application with Oracle Developer Tools, you may need to perform the setups described in the following sections:

	
"Connecting to the Oracle Database".


	
If you are planning to use web site authentication, as described in "Enabling a Web Site for Authentication", you must perform the following setups:.

	
"Creating the User and Granting Privileges"


	
"Configuring All Oracle Providers for ASP.NET"


	
"Setting the Connection String"












Creating a Web Site and Connecting it to the Database

This section shows you how to create an ASP.NET web site that retrieves data from an Oracle database. The web site will display data in an ASP.NET GridView, allowing users to page through the results.

This section contains two topics:

	
Creating an ASP.NET Web Site


	
Creating a Data Source






Creating an ASP.NET Web Site

To create an ASP.NET web site with a grid:

	
Start Visual Studio.


	
From the File menu, select New, then Web Site...

[image: Description of aspnt01.gif follows]




	
From New Web Site, select ASP.NET Web Site and enter or browse to the directory location for the web site. Click OK.

[image: Description of aspnt02.gif follows]




	
In the Default.aspx tab, click the Design icon at the bottom of the screen.

[image: Description of aspnt03.gif follows]




	
In the <div> element, which appears as a dotted rectangle, enter a title, such as Employees List.

[image: Description of aspnt04.gif follows]




	
From the View menu, select Toolbox.

[image: Description of aspnt05.gif follows]




	
Expand the Data group and drag the GridView control into the dotted rectangle labeled <div> of the Designer

[image: Description of aspnt06.gif follows]




	
When a grid with dummy titles and contents appears, view the GridView Tasks list on the right.

[image: Description of aspnt08.gif follows]




If you do not see the task list, select the grid, and then click the > symbol on the right.

[image: Description of asnpt07.gif follows]











Creating a Data Source

To Create a Data Source:

	
Under the GridView Tasks, select <New data source...> from the Choose Data Source list, as shown in step 8 in the previous section.

A Data Source Configuration wizard starts.


	
Select Database. Enter HR as the ID for the data source. Click OK.

[image: Description of aspnt09.gif follows]




	
Click the down arrow to choose HR.ORCL from the list. Click Next.

[image: Description of aspnt10.gif follows]




	
Click Next to save the connection string in the application configuration file.

[image: Description of aspnt11.gif follows]




	
Select the EMPLOYEES table from the Name list. In the Columns list, check the box next to the asterisk ( *).

These selections tell Oracle to return all the rows from the EMPLOYEES table, just as if you had typed SELECT * FROM EMPLOYEES.

Click Next.

[image: Description of aspnt12.gif follows]




	
Click Test Query.

[image: Description of aspnt13.gif follows]




	
Click Finish when the Test Query results appear.

[image: Description of aspnt14.gif follows]




	
From the GridView Tasks, select Enable Paging. If you do not see the task list, select the grid, and then click the > symbol on the right. You may have to scroll right.

[image: Description of aspnt15.gif follows]




	
From the View menu, select Solution Explorer, and then select the web site. Right-click and select Build Web Site. The status bar will indicate success or failure.


	
From the View menu, select Debug, then Start Without Debugging.

A browser window, such as the following, appears, showing the data requested by the query. You can page through the results using the numbers at the lower left section of the page.

[image: Description of aspnt16.gif follows]




	
Close the browser.











Enabling a Web Site for Authentication

This section shows you how to add web site authentication to limit the users that can access the employee data. We will authenticate using an ASP.NET login control, verifying against users created and stored with the Oracle Providers for ASP.NET.

In the section following this, "Enabling Oracle Providers for ASP.NET and Creating a Lightweight Web User", you will take the ASP.NET application you have just built and secure the employee data so that an authorized user can access the information. You will create a web user for the application using Oracle Providers for ASP.NET. This web user starts the web application through the login control, and if the credentials are correct, can then access the employees information.

	
Reopen the web site you created in the previous section.


	
Select View, then Solution Explorer, and click the web site.

[image: Description of aspnt17.gif follows]




	
Right-click on the web site and Add New Item.

[image: Description of aspnt18.gif follows]




	
Select Web Form, enter the name login.aspx and click Add.

[image: Description of aspnt19.gif follows]




	
When the login.aspx page appears, switch to the Design tab.


	
From the View menu, open the Toolbox, expand the Login section, and drag and drop the login control onto the form, into the dotted rectangle labeled <div>.

[image: Description of aspnt20.gif follows]




This is a standard ASP.NET login control, which can retrieve and verify user login credentials stored in the Oracle database.


	
Right-click the login control and select Properties. For DestinationPageUrl, select or enter Default.aspx.

When a user successfully logs in, that user will be directed to the Default.aspx page, which contains the employee data. If a user does not successfully log in, they will be redirected back to the login page.

[image: Description of aspnt21.gif follows]











Enabling Oracle Providers for ASP.NET and Creating a Lightweight Web User

In this section, you will use the ASP.NET Web Site Administration Tool to do the following:

	
Direct the web site to use the Oracle ASP.NET providers.


	
Create a new web user specific to this web site, demonstrating the authentication features added to the site in "Enabling a Web Site for Authentication".




To direct the web site to use the Oracle ASP.NET providers and create new web site users, do the following:

	
In Visual Studio, select Website, then ASP.NET Configuration.

[image: Description of aspnt23.gif follows]




	
When the ASP.NET Web Site Administration Tool appears, select the Provider tab.

[image: Description of aspnt24.gif follows]




	
On the Provider page, select the second link: Select a different provider for each feature (advanced).

[image: Description of aspnt25.gif follows]




	
When the Provider page reappears, change the Membership Provider and Role Provider to the Oracle versions, if they are not selected.

[image: Description of aspnt26.gif follows]




	
Go to the Security tab and under Users, click Select authentication type.

By default, the ASP.NET site uses Windows authentication to identify users. You are building a web site that will identify users by their site-specific logins and passwords. Therefore, the site must be configured to expect to use logins and passwords.

[image: Description of aspnt27.gif follows]






	
When the Security page reappears, choose From the internet and click Done.

[image: Description of aspnt28.gif follows]




	
When the security tab reappears with new links under Users, choose Create user.

[image: Description of aspnt29.gif follows]




	
In the Create User section, enter the information for the user that you are allowing to enter the web site, as shown. Enter a password that contains at least 7 characters, including one non-alphanumeric character.

Click Create User.

[image: Description of aspnt30.gif follows]




	
When the Security page reappears, indicating that your account has been successfully completed, click the Security tab.

[image: Description of aspnt31.gif follows]




Note: Other options for this screen include continuing to create other users or going to a different tab.


	
When the main Security page reappears, under Access Rules, select Manage access rules.

[image: Description of aspnt31a.gif follows]




NOTE: Under Users, there is now one existing user.


	
When the Manage Access Rules section on the Security tab appears, click on Add new access rule.

[image: Description of aspnt32.gif follows]




	
Select Anonymous users and Deny, then click OK.

By default, anonymous access to the web site is enabled. The above settings secure the web site by disabling anonymous access. Now, only authenticated users can view the employee data.

[image: Description of aspnt33.gif follows]




	
The Security page now indicates that the web site denies anonymous users access to the site.

Click Done.

[image: Description of aspnt34.gif follows]




	
Close the browser.









Testing Web Site Authentication

Now that you have created a web user specific to this web site, the web site will allow this user access to the employee data and deny access to all other users, including anonymous users.

In this section, you will attempt to access the employee data as an anonymous user, as an unauthorized user, as an authorized user with an incorrect password, and finally as an authorized user with the correct password. Only in the last scenario will the web site grant access to the employee data.




	
Note:

Five or more consecutive invalid passwords entered for an ASP.NET provider user within a ten minute period will lock the account to prevent unauthorized users from gaining access through password guessing. Oracle Membership Provider sets these security measures through the following properties, which you can modify in the machine.config file or web.config files: MaxInvalidPasswordAttempts (default: 5 attempts) and PasswordAttemptWindow (default: 10 minutes).
If the account is locked, then you can unlock the user by calling the UnlockUser method.









	
From the Debug menu, select Start Without Debugging, and when the login web page appears, change the URL to end with Default.aspx rather than login.aspx and press the enter key.

[image: Description of aspnt39.gif follows]




You are denied access and redirected back to the login page. This shows that anonymous users cannot browse the web site; only users with credentials have access.

[image: Description of aspnt40.gif follows]




If you are experimenting with the authentication mechanism, you will likely repeat this step or try variations. For each variation, either start a new browser or clear the browser cache. Because browsers cache web pages, if you access Default.aspx again, you may see the cached version of this web page. This is not the intended behavior, rather the web page should undergo the ASP.NET provider authentication process, which is accomplished by using a new browser instance or clearing the browser cache.


	
Remove the text of the URL after login.aspx. This returns the URL back to the original state when you first accessed the site.

Enter the User Name Bob and a password that contains at least 7 characters, one of which is non-alphanumeric.

Click Log In.
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The page reappears with the message "Your login attempt was not successful. Please try again."

Bob is not an authorized user. The web site correctly denies access to the user.


	
Enter the user name Anne, but with an incorrect password for that web site user.

Click Log In.
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As the screen shot indicates, the user is denied access, demonstrating that the control could not verify this user's credentials with those stored by the Oracle Membership Provider.


	
Enter the correct password for the web site user.

Click Log In.

The employee data appears. This demonstrates that only authorized users can access the data. Thus, Oracle Providers for ASP.NET provided web site security in a very simple manner.




You have now built a data-driven ASP.NET web application. It performs authentication and retrieves employee data from the database.
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B Copying a Form

Because you will be using this application to learn about various aspects of application development with Oracle, you should make copies of your form for reuse.


To create a copy of an existing form:

	
In the Solution Explorer, right-click on Form1.xx or any other file you need to copy. Select Copy.

If Form1.xx does not appear in the Solution Explorer, from the Project menu, select Show All Files.
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Right-click HR_Connect_CS or other project. Select Paste.
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Right-click Copy of Form1.cs. Select Rename. Change the name of the form to Form2.cs.
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Right-click on Form2.cs, and select Include In Project.
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Right-click on Form1.cs, and select Exclude From Project.

You can include and exclude forms from the project just by reversing these steps.


	



	
Note:

This process generally works smoothly. If you encounter a problem, try running Rebuild Solution from the Build menu.











